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  1 Introduction 

1 Introduction 
Thank you for purchasing our product! 
Virtual Set 2000 (VS2000) is a real-time, 3D computer graphics system especially developed for low budget 
studio productions. The VS2000 is a unique tool for creating Virtual Sets and overlaying 3D computer graphics 
and live video. It is a combination of hardware and software dedicated to specialized TV production graphics for 
use with live video. 
The hardware is a rack mountable box running under Windows with specialized boards for rendering the 3D 
graphics. There is also a rack mountable switching box for connecting the system to its various components as 
well as external devices. 
HotActions software comes pre-installed with VS2000. This is the environment for creation of 3D scenery/sets 
and their interaction with the live video (operation). 
There are four manuals which accompany VS2000. They are: 
• HotActions User’s Guide – Overview and Tutorial. 
• Video and Sound Settings Guide – Detailed technical information on setting up system. 
• 3D Scene Creation Guide – Detailed information for creating rendered scenery and sets. 
• Script Commands Guide – Detailed information for creating scripts for unattended use along with a 

command glossary and script examples. 
Your system comes completely configured and ready for use. No installation procedures are required other than 
connecting the components via their appropriate cables. This document explains the use and functions of this 
unique set of tools for television production. 
Version (1.07) of this document corresponds to version 1.35 of HotActions software for VS2000. 
Television production with VS2000 can be divided into two basic processes: preliminary work and actually 
camera shootings during LiveAction Mode. Typical tasks involved with television show production using VS2000 
include: 
• Preparation of scenario and selection of necessary videos and audio materials, decorations and etc. 
• Creation and export of a 3d-scene, or a set of scenes (including geometry, animation of objects and virtual 

cameras and etc) with the help of the 3D Studio Max program. Familiarity with contents of all manuals 
especially for 3d-scenes creation is recommended. 

• Creation of the project in HotActions, using ready 3d-scenes. The focus of this document is devoted to the 
description of HotActions. 

• Creation of the interface elements for control of studio in LiveAction Mode of HotActions. For example, 
animation of objects or the virtual cameras, executed by pressing assigned buttons or hot-keys. For this 
purpose special HotActions scripts are used. HotActions itself is an environmental builder and interactive 
control set which allows flexible configuration. Sections following 3.1 are devoted to the description of 
flexible configuration. 

• Tuning of parameters of input and output video and a sound using HotActions (as described in separate 
document).  Parameters of output video, such as the television standard (PAL or NTSC) and type of an output 
signal should be correctly adjusted by each user.  Input parameters should be adusted to the operating 
conditions of studio. As a rule, parameters of output video are not required to be changed.  Adjustment of 
parameters of input video is usually required after any change of a configuration of the external equipment.  
And parameters of chroma keying (rear-projection) may need adjustments, for example, if illumination in 
studio has changed. 

• Once ready projects of input and output video are adjusted it is possible to begin execution of the planned 
scenario. Shootings are made in the LiveAction Mode of HotActions. Any necessary adjustments to actions 
can be done directly during shooting either as a change of parameters carried out automatically (as a script 
sequence), or interactively under the control of the operator in LiveAction Mode. 
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Chapter 2 briefly describes a typical working interaction with the system along with the data necessary for starting 
the system and creation of first results with the system.  The configuration of studio VS2000 with analog video is 
also described. 
Special features and corresponding adjustments of a configuration are described to assist users with special 
circumstances. 
The subsequent chapters contain information on all program components of the system, giving full description of 
interfaces and functionality of the current version of software. 
Some typical problems and their solutions are examined in chapter 6 «Troubleshooting». We also recommend 
regularly visiting our WEB and FTP-sites where the latest versions of the software and the documentation, new 
information, user questions and responses are made available for your use. 
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 2.1 Connection of Studio Components and External 
Equipment 

2 Check Points for Start Up of Studio 
This chapter describes setting up your VS2000 and, in particular, acquaints you with the basics for working with 
HotActions. The subsequent chapters go into a greater detail description of this program. Separate documents are 
devoted to the description of adjustments to video and audio as well as 3D-scene generation and how to use the 
script language. 

2.1 Connection of Studio Components and External Equipment 
Before starting all of the components of studio should be properly connected. Detailed instructions are included 
with your VS2000. Section 7.1 of this document presents a simple configuration. 
In particular make sure, that  
• Output DVI connector of the graphic accelerator is connected with input DVI-connector of the DVM board, 

and  
• FD300 board (or boards) is/are connected by special cable to the switching panel (Breakout Box). 
The passive switching panel is described in section 8.  The signal from the switching panel connected to output 
FD300 board usually goes to TV-monitor. Depending on configuration of studio and adjustments of output video 
this signal may be component (YUV or RGB), S-Video, or Composite. Sources of input video such as video 
cameras, video recorders also are connected to the panel. 
The computer monitor, the keyboard and the mouse are connected as usual. 
After checking correctness of connections turn on the system. 

2.2 Check Windows Settings and start HotActions  
If you are working with a one-monitor configuration please carefully read section 6.4.1. 
In a configuration with two video adapters the video adapter with DVI output (GeForce from NVIDIA) must be 
connected and correctly adjusted for work with VS2000. 
For this purpose it is necessary to start Display Properties 
dialog (figure on the right), using Start->Settings-
>Control Panel-> Display Properties or by clicking 
with right button on your desktop and choosing Properties 
from pop-up menu. 
On Settings tab of this dialog tab, if you are using 
multiple monitors, click the monitor icon that represents the 
NVIDIA GeForce. When working with two monitors, the 
check box next to Extend my Windows desktop onto 
this monitor needs to be checked. 
True Color (32bit) should be selected in Colors list. 
Under Screen Area the resolution should be set to 
720 by 576 pixels for the studio working in PAL or 
720 by 480 for NTSC. 
Check that Digital Display is chosen as the output device. 
For NVIDIA drivers of version 44.03 this can be done by 
the following steps: 
1. Open Display Properties dialog. On the Settings 

tab, click Advanced. 
2. Choose the tab with  logo and name of the video adapter (GeForce Ti 4600 at Figure 1). Then at the left 

menu choose nView Display Mode (Figure 1). 
3. Click Device Settings>>, choose Select Output Device in pop-up menu and check up that 

Digital Display is set (Figure 1). 
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Figure 1. nView Display Mode dialog and its Device Selection pop-up menu 

Before exiting the Display Mode dialog and its Device Selection pop-up menu on the left side of Figure 1, select 
the Performance & Quality Settings item. This will open up the dialog for shown in Figure 2 below. 
The recommend settings are: 
• Performance be set to Aggressive. 
• Antialiasing should be set to either 4xS (Direct 3D Only) or Quincunx™. There are five different levels of 

Antialiasing for the GeForce4 Ti4XXX series graphic accelerator cards. 
• Anisotropic filtering is typically set at 4x but 8x will work as well. 
• Texture Sharpening should be checked. 
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  2.2 Check Windows Settings and start HotActions 

 
Figure 2. Performance & Quality Settings Dialog 

To control VS2000 you to must open HotActions. It can be opened from Start menu or by clicking on the 
HotActions icon on your Windows desktop (Figure 3). 

 
Figure 3. Start of HotActions 

HotActions is the main window for management of VS2000 and contains a window captioned Render Output for 
display of rendered video. After necessary adjustments to the output video, the Render Output should appear on 
the adjusted monitor. If window Render Output is not displayed on the desktop choose Center Render Window 
from menu Window of HotActions’s main window to display it in the center of the HotActions. 
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2.3 Video settings 
To adjust video settings, open dialog Options by clicking the right-most button  on the toolbar of the 
HotActions main window (Figure 4) or by choosing Options from menu Tools. In Options dialog choose 
Live Video panel (Figure 5). 

 
Figure 4. Toolbar of the HotActions’s main window. 

 
Figure 5. Live Video panel of Options dialog 

Before starting a project it is necessary to adjust output video. The correct TV-format (Figure 5) should be 
specified on the panel Live Video near the button Format (Output controls group). If a different video Format 
is required, click on the Format button to access the Format dialog. 
The Mode button opens Output Mode Configure dialog (Figure 6). 
In controls group Analog Video Output of this dialog the type output signal (componential, S-Video or 
composite) is selected. By default in this list parameter ColorBar YUV+CVBS is selected for outputting test color 
bars. 
From drop-down Mode list (Figure 6), please select the required mode. Select Genlock if your configuration 
provides Genlock-signal.  In the minimal configuration mode No Genlock will be selected. 
In case of Genlock system set type of synchronization in Genlock Internal Video list by choosing Line A for 
synchronization with video signal of the board’s first channel. 

* It strongly recommended to choose synchronization to the first (Line A) or to the second (Line B) of the 
used video sources. 

For the first start of the system we recommend to leave other adjustments at their default settings. 
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Figure 6. Output Mode Configure dialog for selected Genlock mode 

Now the adjustment of output video is completed. If the format (see 2.2) and type of the output signal (Figure 6) 
are correctly specified there should be a background of Windows desktop on the second monitor. Move to it the 
Render Output window. If the image on the second monitor is absent turn to section 6.4.4. 
For adjustment of input video group Input(s) serves (panel Live Video of Options dialog (Figure 5). It allows 
adjusting parameters for input boards. 
Drop-down list in Input(s) allows choosing a board to adjust. The number of items in this list (LIVE_1, LIVE_2 
etc.) correspond with the number of input boards in system. To each input board may be connected up to two 
independent video sources. It is only possible to get input from one source at a time, switching between input 
channels however is possible. Thus, the maximum number of independent streams of live video in any scene is 
equal to double the number of input boards. 

* If your configuration provides several boards, on Input(s) list the boards appropriate to them should be 
determined by practical consideration.  For this purpose it is necessary to choose any number from the list 
and, having determined a correct input and its format to try to receive the image.  If it is not possible, the 
number is chosen incorrectly. Please notice, that the format of input video is determined by format of output 
video. 

Also for input video, from Input(s) list it is possible to establish the effective resolution by Full Resolution 
(720 pixels) or Half Resolution (352 pixels). 
For example, choose LIVE_1 for adjustment of the first input board and set mode Full resolution.  Click Source 
in Line A group to select the first channel of the board.  Dialog Select Video Source (Figure 7) will open.  In drop-
down Input list of this dialog select correct input of the switching panel on for the signal. Other parameters of the 
dialog are intended for adjustment of brightness, contrast etc. To check input settings of VS2000, you can set these 
values to their defaults by clicking Default. If you get an image from the camera in Select Video Source dialog, 
you can exit the dialog with a click on OK. 
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Figure 7. Select Video Source dialog 

Now it is necessary to adjust keying parameters (chroma key) for the chosen channel.  On panel Live Video 
(Figure 5) of the dialog Options in the group for Line A, choose Universal Key algorithm from the keying table.  
After pressing Key Configure the KeyConfigPro dialog (Figure 8) will open.  Detail for this dialog and its 
adjustment mechanisms are described further in this document . Press the 

 
button for an automatic method of 

construction of the table of adjustments.  This usually yields good results with sufficient illumination and a high 
quality background. Press button  Close to close KeyConfigPro dialog and to load the constructed table for 
keying. 
It is necessary to make similar adjustments to the second channel of input board LIVE_1 – Line B. In 
Select Video Source (Figure 7) you can choose the same signal as for Line A. 
When you close HotActions all parameters for adjustment of the video, including those for the input signals and 
adjustments of a keying are saved.  At the subsequent start of HotActions all adjustments are automatically 
restored. It is recommended after adjusting both video channels for any input board to keep the configuration 
parameters as a Preset.  For this purpose it is necessary to type any name without spaces in drop-down list in the 
Presets group of panel Live Video (Figure 5) and to click on the Save Button.  For more details see the 
document on adjustment of video. 
Note that it is necessary to set different names for configurations of different boards (LIVE_1, LIVE_2 etc.). If 
the configurations are not kept with an obviously useful name, after closing the HotActions these configurations 
are stored with the predefined names like «AutoSaveN», where N (1, 2 etc.) corresponds to number of input 
board LIVE_N. 
If the Input (s) drop-down list has other input boards (LIVE_2 etc.), it is necessary to repeat the adjustment 
procedures for each of them. 

8 Chapter 2   Check Points for Start Up of Studio 



  2.4 Sound settings 

 
Figure 8. KeyConfigPro dialog for Universal key algorithm 

2.4 Sound settings 
Connection of external audio equipment is made with the help of the Breakout Box (see 8). All sound files 
playbacked by HotActions, for example wav-files started from commands of a script, will play back on the sound 
card chosen in the system by default. To combine this audio stream with sound from cameras or other sources, it 
is necessary to make adjustments to the system: 
In Start->Settings->Control Panel->Sounds and Multimedia->Audio from Preferred Device drop-
down list (of group Sound Playback) select as the output device one of the output channels of FD300 board. The 
mixing mode of a sound in VS2000 can be set in the Sound Configure dialog (see the document on adjustment of 
video and a sound). 

2.5 Work with sample project 
Once input and output video as well as sound settings are properly adjusted and components and external 
equipment connected to the system, you are ready to create a project with HotActions.  We will create a sample 
project to illustrate how to use HotActions. 
From the File menu of the main window of HotActions choose command Open Project… this will open the 
standard Open dialog where you can choose one of the sample projects that come with HotActions.  Select the 
project Sport. (Figure 9) Once a project is opened, it will appear in the contextual menu command 
Recent Projects.  You can use the Recent Projects command to reopen the project.  
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While loading the Sport project position all windows and observe that all settings, files and documents associated 
with the project are referenced and available. They are sorted by groups, in the project window with heading 
Sport.vsp.  For more detail about projects, turn to section 3.6. 
The window with the heading Sport.hot directly controls the scene. This window is referred to as the Hotset. 
Hotset contains floating panels of tools called HotBars. Later you learn how to create customize floating panels 
and also how to change names and functionality of all buttons on the floating panels (see section 3.5). 
Now we are ready to work with the Sport project.  

• Press button Init  for initialization of a scene.  If the previous steps are done correctly, the Render Output 
window with the first frame of the Sport project video is displayed. 

• Press button Start LiveAction . This button is on the toolbar of the main window and used for switching 
the program between edit and live action modes. When engaged, the Start Live Action button will change its 
appearance to . 

 
Figure 9. An example of work with studio with loaded Sport project 

In LiveAction mode the program by default switches to the full screen mode (Fullscreen), and all windows, 
except for Hotset’s windows, are hidden or minimized. Adjustments to the display in LiveAction mode are 
detailed in section 5.1. 
• Press button Play Sport on the Hotset floating toolbar to show the scene with its tracks (Figure 9).  For other 

projects the Play button usually refers to the associated project: i.e. Play+the name of project.  Buttons on 
other floating toolbars of this project such as Camera are intended for management of the virtual cameras. 

• Press the button . This will switch you from operating condition (live action) to editing mode.  Note when 
in Edit mode, the buttons on the floating tool bars are not available for use. However, you can utilize any 
button on the floating tool bars if you first press the Alt key as you click on the button. You will then be able 
to see the result in the Render Output window.  

You have now successfully started the Sport example and we will now go through a detailed step by step working 
session with the system in the subsequent sections. 
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3 Application HotActions 
Application HotActions is intended for creation and control of 3D computer rendered scenery for interaction with 
real-time live video. It also configures the environment for interactive control of the 3D-scene under operating 
conditions.  
Working with HotActions includes three basic stages: 
• Preparation of animated objects (position, parameters, textures etc.) and virtual cameras for use in three-

dimensional scenes along with creation of appropriate interface elements for management of studio while in 
live action mode. 

• Configuring of input and output video through the Live Video panel for use with HotActions. 
• Operation in LiveAction mode with the help of the created interface elements either by manual control or by 

for execution of a script. 

3.1 Basic HotActions concepts 
To understand the workings of the HotActions program, we shall describe a few basic concepts: Project, Action, 
Actions Library, Hotset, Hotbar, LiveAction. 

3.1.1 What is a Project? 
HotActions creates projects. References to all associated files, scripts, settings are saved in a project file.  The 
project file ends in (*.vsp). It also contains information on the condition of files (open, hidden or closed), 
windows, tools panels and other settings. It is a convenient way of accessing all the files associated with a 
particular project. (Figure 10) 
In HotActions only one project can be open at a time. Closing a window of the project will close all windows 
connected to it. 
The window of each project contains standard groups.  Standard Groups are separate folders for each standard 
type of files with which HotActions works.  As files are added to the project they automatically saved in the 
appropriate folder/group. Also the user can create Custom Groups, i.e. groups that do not adhere to a certain file 
type. References to any files used by a HotActions project are saved with the project file. 

 
Figure 10. The example of the project open window 

The contextual menus appear with a right mouse right button click on a group name or a file in it. Control details 
for the project appear in section 3.6. 

3.1.2 What is an Action? 
Action is one or several text commands which result in any updating of a virtual scene. This concept is basic to 
HotActions.  Actions, in particular, concern: 
• loading of files, scenes, textures, sound etc.; 
• switching of virtual cameras; 
• start/stop of animation of one or several objects; 
• playback/stop of sound; 
• change of any properties of scene elements (for example, visibilities, scale, position, color etc.). 
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One Action can effect others Actions to create scene sequences. 
An Action is initiated by the user (the operator of 3D-scenery) by pressing one button on Hotbar or a hot key 
during interactive control of the scene (LiveAction). 
A group with special attributes is the startup Actions group. They represent the sets of commands, which are 
automatically carried out during a transition to operating conditions - LiveAction. The task of startup Actions is 
initiating a scene to an initial (base) condition, as well as loading and naming necessary components. For more 
about creation of startup Actions look in section 3.11.2. 
Actions are kept in the system as text documents in Actions Libraries.  Details about Action Libraries is given 
below. 

3.1.3 What is an Actions Library? 
Actions Library is the set (library) made up of several Actions, incorporated in one document (a file with 
extension .acl). 
As a rule, Actions are united in libraries by common attribute; for example, they concern one 3D-scene in the 
project.  In the majority of projects there is only one Action’s library. 
More often the designer/animator or the program director creates the Actions Library and are thus familiar with 
its structure. 
Every Action represents an executed script of commands. Any Action can be associated with a certain button on 
the floating tools panel Hotbar.  Thus when making a new project, it is necessary to create at least one Hotbar. 

3.1.4 What are Hotbars and Hotsets? 
Hotbars – the push-button panels associated with the Hotset for a project. These are directly used in Live Action 
mode as the basic interface for control of a scene. 

 
Figure 11. Hotbar and Hotset – the basic tools of HotActions 

Hotsets – sets of Hotbars. The appearance of the Hotset can be altered by the display of Hotbars. They can be 
hidden, shown or moved simultaneously. (Figure 11) 

Each button of a Hotbar corresponds to a certain Action.  By default their names include the project name.  On any 
Hotbar you can add buttons and associated any Action from the Actions libraries.  If you simply put them on an 
empty seat on Hotset, a new Hotbar will be created. Look at sections 3.4.2 and 3.5.2 for more about working with 
Actions.  
HotActions works with following file types: 

• scenes (files with extension *.3d); 
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• Hotsets (files with extension *.hot); 
• library of Actions (files with extension *.acl); 
• projects (files with extension *.vsp); 
• text documents (files with extension *.txt). 

The Project file maintains references to the other file types and allows working with them simultaneously. 
All files for the project open at once as the project is opened. Existing projects can be opened from File menu of 
the main HotActions window by the command Open Project…. After first opening a project, the name of Project 
appears in the local menu of command Recent Project, and the project can be re-opened from there.  
For each type of file the project window contains separate folders – Standard Groups.  Also it is possible to 
create Custom Groups – these are  groups that do not adhere to specific file types.  More detail about working 
with files in the project is in section 3.6.2. 
To open a file, which is not associated with the Project, in File menu choose command Open…. In the Open 
dialog choose the desired file name. Displayed files can be limited to a certain file extension. Once a file has been 
opened, it can be re-opened faster by selecting it under the command Recent Files on the File menu.  When a 
new file is opened the program always will ask if you would like to add it to the current project if any project is 
loaded. 
If unsaved changes have been created in an open file, the file name appear in the heading of the window with the 
symbol * after the file name. This symbol will disappear after the first saving of the current condition of the file. 

For saving of changes to any type of choose command Save on the File menu or its equivalent – the button  
on the tools panel. If want to save a file with a different name, use the command Save As…. In all open files, 
except for scene files, the button  saves changes to all open files. 

Features about the use of each file type appear in later sections of this document. 

3.1.5 The Properties dialog 
The Properties dialog for any window or object is available by either pressing the keys Alt-Enter  or using the 
button  on the tool bar of the main window. The properties dialog for any object or window will then be 
displayed. To make the Properties dialog disappear, perform a repeat pressing of these buttons.  
By default the properties dialog appears attached to a right edge of the main window (Docking View) but it can be 
transformed into a floating dialog by clicking on the top border of the dialog while holding the Ctrl key.  A double 
click on its heading will re-attach the Properties dialog to the right edge of the main window. 

3.1.6 Work modes Edit and LiveAction 
HotActions works in two modes: Edit (editing) and LiveAction (operating). The program opens in Edit mode but 
all associated files such as Actions Libraries, Hotsets, and Hotbars are open and available for work in LiveAction 
mode.  
When changing to Live Action mode, the program always asks if you wish to save changes to the project and its 
contents.  In LiveAction mode, there is an option which allows interactive management of the 3D scene (i.e. either 
shooting or demonstration).  The application default is Fullscreen while in LiveAction mode, and all windows for 
adjustments of parameters are hidden or minimized (see 5.1). In addition, access to the special folder $STARTUP 
$ is initiated. Here the program will find Actions required for the initial performance of some special actions on 
the three-dimensional scene, for example, the starting trajectories of objects, etc. (section 3.11.1). 
As a rule, the user in this mode is controlling a virtual scene. By pressing buttons on the Hotbar, the operator 
starts certain Actions.  An Action can also be invoked by pressing a pre-assigned hot key on the keyboard.  
Simultaneously control of objects in the scene can be carried out by use of a joystick or other control devices, 
either directly or over a network – with the help of the application for on-air automation. 

* Strongly recommended to close all other active applications before switching to LiveAction mode!  
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Note in LiveAction mode: 
• files, are not closed, but only are hidden and are available by a click on the dagger in a corner of their window; 
• a double click on the heading of a library window, a scene or alternative representation of Hotset 

(section 3.5.5) results in expansion of this window to full screen.  To return these windows to their usual 
condition, use Ctrl-Tab. 

• .In Live Action mode, Hot Keys can be used to initiate actions. To assign Hot Keys, click on a Button in a Hot 
Bar and then perform a right mouse button click to present a Contextual Menu and access Hot Key panel the 
Properties dialog (Figure 12). 

 
Figure 12. Hot Key Panel on Button Properties Dialog 

In the following sections detailed information on all components of HotActions is presented. 
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3.2 HotActions main window 

 
Figure 13. HotActions main window 

The main window of the application HotActions (Figure 13) contains tool bars, standard menus, which contain 
commands for opening, editing, copying and saving of all type files.  Additional dynamic menus will appear when 
specific modules are utilized such as Action Libraries, Projects, Hotsets and their accompanying Hotbars, 3D 
Scenes and Sound Editor. 

3.2.1 Tool Bars 
The main window of HotActions contains three tool bars: Standard, General and LiveAction. Display of any tool 
bar is controlled through the submenu Toolbars on the View menu. 
By default panels Standard and General (the following figure) appear attached to the top edge of the main 
window (Docking View), and panel LiveAction is hidden. 

 
Any panels of the main window, and also Properties dialog, can be placed in a detached condition by pressing on 
the Ctrl key and can they be placed on the screen where it is convenient to the user. A double click on its heading 
will return any window to the attached position. 
Buttons on the tools panels carry out the functions listed in the following sections. For all buttons we show their 
equivalent menu commands. 

3.2.2 Standard Tool Bar 

 (command New from menu File) creates a new file for use in HotActions; 

 (command Open from menu File) shows dialog listing files that can be opened; 

 (command Save from menu File) saves changes in the current active window and in the file appropriate 
to it; 

 saves changes in all open windows and in the files appropriate to them, except for scene files; 

 (command Cut from menu Edit) clears clipboard and moves chosen object or text to the clipboard; 

 (command Copy from menu Edit) copies chosen object or text from active window to clipboard; 
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 (command Paste from menu Edit) adds contents of the clipboard to the current window and in the file 
appropriate to it. 

3.2.3 General Tool Bar 

 (option FullScreen Render from menu View) switches to full-screen mode and back to window mode 
for Render Output; 

 (option Debug Output from menu View) opens and hides a window of diagnostic messages output 
Debug Output, error messages and system events (section 5.3); 

 (option Properties from menu View) opens the Properties dialog; 

 (command Update All from menu Tools) updates and reloads all open files; 

 (command Init All from menu Tools) starts Actions from Startup folder (section 3.11.2); 

 (command Stop All from menu Tools) stops performance of all Actions and playing of all tracks; 

 (option LiveAction Mode from menu Tools) switches application to operating condition (section 3.8); 

 (option Sound Configure... from menu Tools) opens dialog for audio settings; 

 (command Options from menu Tools) opens the Options dialog (section 4). 

3.2.4 LiveAction Tool Bar 

 
The LiveAction Bar is usually attached to the right edge of the main window and contains commands for control 
of LiveAction mode.  Buttons on this panel have the following functions: 

 

switches application from editing mode to operating mode in LiveAction and back; 

 

if a Hotset is open this starts Actions from $STARTUP$ folder; 

 

stops executing of all Actions and any buttons that have been pressed will be restored to their default 
positions. 

 

opens the settings in audio dialog. 

3.2.5 Menus 
The main window contains the standard menus: File, Edit, View, Tools, Window and Help. Many commands 
on these menus are duplicates of buttons on the tools panel of the main window as described above. 
Commands on the File menu execute standard operations, for example, creations of a new file or opening an 
existing file. It is the menu that also lists most frequently used files. Command Exit finishes all work with the 
program. 
Menu Edit contains commands of standard editing. 
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The View menu commands display or hide in windows for tools panels, condition line, output result window and 
the window for diagnostic messages. The contents of the View menu vary with different windows. 
Menu Tools contains the basic execution commands of HotActions. 
Commands the Window menu arrange all open working windows as desired by the user. 
Command About HotActions... from menu Help shows the information about the current version of the 
application. 
Additional menus such as Project, Track, Action, Hotset, appear in conjunction with specific windows. 
The contextual menu (Figure 14) appears with a click of the right mouse button on any area of the main window. 
It contains commands for control of LiveAction mode. Thus there are a variety of methods of control 
conveniently available to the user. 

 
Figure 14. The contextual menu 

3.3 Operations with 3D-scene 
The primary purpose of HotActions is to control computer generated sets that can dynamically interact with a live 
video source. The 3D Scene module contains the tools to control the 3D scenes. These files are saved with the file 
extension .3D. Since we are in the sample project Sport, from the Open command on the File menu select the file 
sport.3D. 

3.3.1 Operating with a scene file 
Scenes, as well as other files used by HotActions, simultaneously open as the project is opened. To add a scene to 
an open project, use the contextual menu for standard group Scenes in the window of the project. 
To open a scene not associated with the project, use the Open… on the File menu. This file will now be listed 
under the command Recent Files on the File menu for faster access. Before opening a new file the program will 
ask if it is necessary to add it to the current project. 

For saving changes in a scene choose the command Save from menu File or its equivalent – the button  on 
the tools panel.  If it is to be saved as a different file name, use the command Save As…. 
HotActions will not preservation manipulations of objects in a scene, i.e. concealment, change of their sizes and 
positions. You must perform a save to keep any changes. The symbol «*» will appear in the heading name of the 
window to remind you when changes have occurred. This symbol will disappear after saving the current scene. 

3.3.2 Organization of scene objects 
When working with a scene in the main window of the HotActions there is a window displaying a file tree 
structure for objects used by the scene.  This window has the scene name in its heading.  All scene objects are 
organized in the tree structure in the following manner. This structure can be found in Figure 15. 

  root object of scene tree (World), there is only one for each scene; 

 empty (Dummy) scene objects which have no sides, are not drawn and are used for 
auxiliary purposes.  For example the control of a camera in a scene by a joystick or mouse 
is not directly on the camera but via empty objects.  Thus for control purposes cameras 
should be connected to a Dummy object; 

 the scene units referred to as solid object, these are objects with rendered sides; 

 the cameras available in a scene; 
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 the light sources in a scene. 
You can hide objects in a scene with a double click of the left mouse button on the object or objects group. 
There are additional graphical badges for objects: 

• the small green triangle, for example , means, that the object has a track in the common scene track; 
• the small yellow triangle, for example , means, that descendants of object have tracks in the common scene 

track. 
Use of tracks is described in section 3.11.2 of this document and also in the Script Commands Guide. 

3.3.3 Tool bar of scene window 
Buttons on the active scene window tool bar are: 

• the button  represents all scene objects as a tree (Figure 15).  A contextual menu for each object or group 
on the tree appears by clicking the right mouse button. From the contextual menu you can hide/show the 
chosen object in a scene, copy its name to generate commands in a script describing the current site of object 
(see below the description of action of the button  further) or display properties dialog. 

 
Figure 15. Working window of a scene and the contextual menu for its objects 

The contextual menu of scene window contains the following commands: 
Hide hides the current element in a scene; 
Reset restores position and the size of the current elements in a scene, setting their values to what 

they were at opening the current scene. Accordingly, the command only becomes 
accessible after a change of position and/or the size of object.  The symbol «*» is added at 
the end of the object name in the scene window whenever any unsaved changes have been 
created; 

Copy Name this command copies the name of the chosen element to the clipboard for further use, for 
example, in the script commands. To insert the object name copied by this command, use 
command Paste from the contextual menu; 

Copy XForm corresponds to actions executed by pressing the button ; 
Properties calls the Properties dialog (section 3.3.5) for chosen element. 

• the button  represents all grids or Meshes available for scene objects (Figure 16); 
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Figure 16. Representation of all scene grids and the contextual menu for grids 

• the button  shows all cameras in the scene (Figure 17); 

 
Figure 17. Representation of all scene cameras and the contextual menu for camera 

• the button  shows all light sources in the scene (Figure 18); 

 
Figure 18. Representation of all scene light sources and the contextual menu for lights 

• the button  shows all materials for scene objects (Figure 19); 

 
Figure 19. Representation of all scene materials and the contextual menu for materials 

• the button  generates script commands describing the current position of object and its size (XForm).  Use 
this button for creation of a command to note any change of position and size of a chosen object from its initial 
settings.  The commands will be created and copied to the clipboard.  Then the script lines can be inserted into 
the Body field in Properties panel for Action by the command Paste on the contextual menu.  Note that the 
button  in Figures 15 – 18 is inaccessible, since the editing tools panel of the main window is intended for 
files, in this case – scenes, and for this Paste is not available; 

• the button  restores position of all scene objects, but does not cancel their concealment if this has been 
applied to an object; 

• the buttons  serve for playback, rewind and a stop of the scene track. These buttons can be 
used before you initialize a scene. They are used for viewing a scene track taken separately – without Action 
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Libraries and etc. Thus, as a rule, the tracks of solid named objects used in commands will be excluded from 
play by these buttons of the tool bar. They are intended for playing the common scene track as defined.  

A right mouse button click on any scene objects will display the contextual menu shown in Figure 20. The menu 
contains commands similar to buttons on the tool bar of the scene window, and also View menu for the scene 
window. 

 
Figure 20. The scene contextual menu 

3.3.4 Dynamic Menu – Scene 
When working with the 3D Scene module in the HotActions main window a special menu Scene (Figure 21) will 
appear and the contents of the Edit menu is slightly altered. Commands of the Scene menu include: Play, 
Rewind, Reset All Nodes and Stop duplicate buttons of a working scene window. And commands of menu 
Edit have the additional commands Copy Name and Copy Xform which duplicate buttons of a working scene 
window described above. 

   
Figure 21. Menus Scene and Edit of main window for scene 

3.3.5 Properties dialog for different types of scene objects 
The Properties dialog can be displayed for any object, camera, light source, grids and scene materials by first 
clicking on the icon for the object, camera etc and then performing a right mouse click. The Properties dialog 
provides detailed information for the selected item. 
This information is divided for convenience between the appropriate panels, which are accessed by tabs at the 
bottom of the dialog. 
The Node Panel (Figure 22), which is on the Properties dialog for every type of object, shows the name, position, 
the size (this parameter has no value for cameras), and positions shifts for the scene object. It is possible to change 
these parameters and to accept changes, by pressing Apply or to restore to starting position of object, by pressing 
Reset. 
With a click on Hide, it is possible to hide the object in a scene. 
A click on the button Control, as well as double click on object, makes it controllable by a joystick, the mouse or 
arrow keys.  More about manipulation of objects by use of a Joystick, is described in section 3.9. 
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Figure 22. Panel Node of dialog Properties 

The Node panel is the only panel for empty Dummy objects, designated by .  The Properties dialog for all 
other objects have additional panels. 
CAMERAS 
For cameras the Camera panel (Figure 23) allows the user to set the parameter FOV (angle of sight) in 
degrees or a focal length of a lens in millimeters – if button Lens is engaged. Also the panel allows to set the 
parameters Clipped Planes and simulate fog through the parameter Environment Ranges for the chosen 
camera. 
Button Set Active sets the camera for the current scene, but does not choose it as an object for a 
manipulation.  For this purpose it should be selected on the Node panel from the tree of objects for the scene 
(Figure 20). 

 
Figure 23. Panel Camera of dialog Properties for camera in a scene 

Solid (Rendered) Objects 
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For solid (rendered) scene objects (those having sides), the additional Mesh panel (Figure 24) presents 
information on number of sides (faces) and corners (vertices) for the object and material used.  Button 
Find in Scene helps locate the object in the scene by causing a grid of the object to blink. 

 
Figure 24. Panel Mesh of dialog Properties 

LIGHT SOURCES 
For light sources in a scene the Light panel (Figure 25) includes the option On to set color of light source.  A 
click on the field Color presents a dialog for selecting a color.  Also the panel permits specification of intensity by 
setting the Multiplier value. 

 
Figure 25. Panel Light of dialog Properties for light sources in a scene 

For any object not represented either on the scene tree (Figure 15), and in groups (Figure 16, Figure 17, 
Figure 18,Figure 19), Properties dialog contains information appropriate to type of object as described for the 
additional panels listed above – only without the Node panel. 
MATERIALS 
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Since materials are not assigned to concrete objects in a scene they do not have the Node panel.  Their properties 
(Figure 19) can be looked at in the panel shown in Figure 26, simply select a concrete material from the list of 
available scene materials. To access the Material Properties dialog, click on the Material Button  in the 3D 
Scene window, and then execute a ALT+ENT key combination. 
Figure 26 displays the parameters for the material that are available to you: its Colors – Ambient, Diffuse and 
Specular, Self-Illum. (luminosity), Opacity (transparency) and degree of display of patches of light in field 
GLOSSINESS.  If the material is a texture map it is represented in dialog with information on its sizes and type. It 
is possible to find materials in a scene, by pressing button Find in Scene. 

 
Figure 26. Panel Material for the materials in scene 

TRACK 
If the scene object or at its descendants has a separate track in the common scene track, in the Properties panel 
anther button is added - Track (Figure 27). 

 
Figure 27. Panel Track of Properties dialog 
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The Track panel contains the information on the object’s track separate from its components.  Changes of a 
position, an angle of rotation (turning and spinning) and scale of the object (size) are represented on the panel by 
corresponding color rectangulars on the appropriate line of the track (Figure 27).  The color of the rectangulars 
depends on which radio-button is chosen from group parameters Show. 
The group of radio-buttons Show allows to group and show the following tracks: 
• Own – (green) own tracks of object  
• Sub – (yellow) information on tracks of object’s descendants  
• Both – (blue) data for object’s own tracks together with information about the tracks of it’s descendants  
ENVIRONMENT 
For the root object of a scene tree (World), designated by the icon , the Properties dialog contains the 
additional panel Environment shown in Figure 28. 

 
Figure 28. Panel Environment of dialog Properties for object World 

On this panel are three parameter groups:  
• Ambient Lighting - illumination level of the scene by a diffused light is controlled. Click with the left mouse 

button on field Color to open a dialog for selection of a color.  
• Background - similarly you can set color of a background, i.e. the space, which is not occupied within the 

scene by objects. 
• Fog allows use of a fog effect in the scene.  For this purpose set option Fog and also set the color for Fog in 

field Color.  Parameters Near and Far set, in percentage, a factor of mixing of the fog with the stage on a near 
and distant plane of each virtual camera.  These planes are set in parameters group Environment Ranges of 
Properties dialog for the Camera panel (Figure 28) and you can assign different environments for each virtual 
scene cameras. 

3.4 Operations with Actions Library 
The Actions Library refers to the files that control the movement of objects in a scene.  Actions can be named, 
copied, pasted, deleted just like other files.  They are controlled on the Actions Properties dialog discussed in 
section 3.4.2 and shown in Figure 33. 
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3.4.1 Utilizing library files 
To create a new Actions Library library select the New in the File menu of the main window of HotAction and 
then choose Actions Library in New dialog (Figure 29).  This dialogue can also be opened by pressing the keys 
Ctrl+N or clicking on the button  on the tools bar of the main window. 

 
Figure 29. Dialog of a choice such as a new file for creation 

Usually libraries, as well as other files used by HotActions, open as the project is opened.  A contextual menu for 
standard group Libraries is available in the project window. 
It is possible to open a library created earlier through the Open command on the File Menu instead of switching to 
it from within an open project.  You may want to do this for example, for copying some Actions from the 
previously created library.  For this purpose in menu File of window HotActions choose command Open… then 
in Open dialog replace type of files to be Action Library Files (*.acl) (Figure 30).  Then select the desired file 
and click on Open button.  A request will appear in the dialog asking you to confirm if you want the file included 
in the current project – click on No.  The Action Library File will now open faster – by selecting its name from 
the list of Recent Files also on File menu. 
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Figure 30. Standard dialog for opening file 

For preservation of changes in a library choose Save command in the File menu or its equivalent – the button 
 on the tool bar.  If you want to save it using a different name use the command Save As…. 

3.4.2 Using Actions in the library 
In the Actions Library it is possible to address files in a folder using the usual commands copy, delete etc.  It is 
possible to access these actions or a group of Actions in the standard way using arrow keys or holding the Ctrl or 
Shift keys. 
A click of the right mouse button on an empty place within the Actions Library window opens the contextual 
menu shown in Figure 31. This menu is a combination of commands for the Action and View menus in the main 
window, described in detail in section 3.4.3. 

 
Figure 31. Contextual menu of Actions Library 
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Figure 32. Contextual menu for  Action in library 

If a right mouse click is executed on an Action listed in the Action Libraries window, a different contextual menu 
illustrated in Figure 33 is presented.  If the command Edit is chosen from this contextual menu, the Properties 
dialog shown in Figure 33 is presented.  It is possible to display the Properties dialogue by choosing the 
command Properties from the contextual menu for Action, or by pressing keys Alt+Enter. 
After the display of the Action Properties dialog, it is possible to test the script for the action by pressing the Test 
button in the Properties dialog.  The Body panel of this dialog shows the actual script used to effect the Action.  
The script is comprised of commands that are described in detail in the Script Commands Guide.  The Apply 
button simply keeps any changes to the Action script without executing the Action (Figure 33).  To keep all 
global changes in the library, it is possible to use the keys Ctrl+S. If you turn on Auto by checking the box next 
to Auto any changes in the body (script) of Action are automatically saved. 

 
Figure 33. Dialog Properties for Action 

The appearance of the icon of an Action can be altered if it is used by a different Hotsets .  Plus it is also possible 
to drag-n-drop icons between open libraries as a copy method. 
When moving Actions on the Hotbar the appropriate buttons are automatically added. If placed on an empty seat 
on Hotset a new Hotbar will be created (more on this topic in section 3.5). 
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3.4.3 Working menus of Actions Library window 
Along with the standard menus, the Action Library window has the added menu Action and the View menu is 
altered as well. See (Figure 34). 

  
Figure 34. Menus Action and View of main window 

Menu Action contains the following commands: 
• New creates a new Action 
• Rename changes the name of existing Action 
• Edit opens the dialog Action Properties for editing script of Action. 
• Delete deletes the chosen Action. 
The View menu contains the following items for working with the Actions Libraries: 
• Large Icons, Small Icons, List and Details changes the appearance of the Action Library window. 
• Auto Arrange automatically arranges icons in the Actions Library window. 
• Line up places icons in rows in the Actions Library window. 
To look at the Actions Library you can execute the View command on the contextual menu of library window 
(Figure 31). 

3.5 Operations with Hotset 

3.5.1 Using Hotset’s files 
Hotsets are created and opened similarly to the Actions Library files: 
A new Hotset can be created by accessing the command New on the File menu and then selecting Hotset Panel 
in New dialog (Figure 35).  This dialog can also be invoked by pressing the keys Ctrl+N in the HotActions main 
window. 
As with all project files, Hotsets are opened as the project is opened. But, unlike other types of files that work 
with HotActions, Hotsets are seldom used outside the project for which they are created. 
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Figure 35. Dialog to make a new file for creation of a Hotset 

It is possible to open a Hotset without opening its project by using the command Open on the File menu.  Once 
open, the Hotset file will appear on the list of Recent Files on File menu. 
The contextual menu is available for the Hotset is in the project window.  

To save a Hotset under a different name use the command Save As… on menu File. The button  or command 
Save keeps it under its current name. 

3.5.2 Manipulation HotBar buttons and their properties in Hotset 
In edit mode, the control environment for HotActions (see 3.1), it , it is possible to alter HotBar buttons in Hotset.  
On any Hotbar it is possible to add buttons by moving the button directly on to it from the Actions Library.  If 
they are moved to an empty spot on Hotset a new Hotbar will be created. 
Buttons can also be freely manipulated: 
• to change their text or create icons or snapshots equivalent to hot keys (keyboard shortcut) access the 

Properties dialog (seeFigure 37); 
• to delete, add, copy buttons use the contextual menu (Figure 36); 
• to change their order on Hotbar or move them between Hotbars and Hotsets you can drag the icons. 
Thus to Edit a button, simple click on the selected button instead of pressing.  To test action of the button, click 
on it, while holding the Alt key. 
From Hotbars it is also possible to move the mouse between Hotsets. 

*  Remember that Hotset does not contain actual Actions – it contains only references to libraries of Actions.  
When opening Hotset the program automatically loads required libraries.  For this reason Hotset is not 
dependent on the description of any particular Action. 

To change properties of buttons use the Properties dialog shown in Figure 37). It is opened with the command 
Properties of the contextual menu in Hotsets (Figure 36) or pressing the keys Alt+Enter. Other commands of 
the contextual menu serve for control of buttons as well. 
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Figure 36. Contextual menu for buttons 

 
Figure 37. Dialog Properties for buttons 

The Properties dialog has four tabs, which access four different panels: 
• Button – for naming buttons and associating with an Action 
• Hotkey – for assigning Actions to specific keyboard key sets 
• Icon – for altering the appearance of a button by either assigning a graphic or a snapshot from the Render 

Output window 
• Action – for creating and editing actions. 
Button Panel 
In field Button Name it is possible to change the name of the button. The description of the button in the field 
Description is obtained from the Action associated with the button. Reference to this Action is found on drop-
down list Target Action.  In the drop-down list for Target Library can be found the library for the Target 
Action. To replace this library, first change the Action using the drop-down list Target Action, then use the 
Target Library drop-down list. 
To change the Radio Group for the Action use the drop-down list Radio Group. It is possible to create new 
radio-group or to choose from existing Radio Group from the drop-down list. 
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Clicking on the  Apply button of Properties dialog keeps all changes but does not close the dialog. 
Hotkey Panel 
You use the Hotkey Panel to make a key board button equivalent to an Icon on the HotBar. This panel is also 
used to replace any Hotkey for a different hot key (keyboard shortcut). 
Icon Panel 
The Icon Panel controls the appearance of button on any HotBar. New actions can be assigned to a button from 
the Icon panel as well.  You can use customized graphics or even a captured image (Snapshot) from the project 
video. Changing the appearance of an icon involves the use of two Properties dialogs. 
• Click on the title bar for the HotBar to which the button belongs and then access the Properties dialog for the 

HotBar by pressing ALT+ENT. This will present the HotBar Properties dialog below (Figure 38). 

 
Figure 38. Hotbar Properties Panel 

• In the HotBar Properties dialog, you can set or change the HotBar name (Hotbar Name) , add a description 
(Description), specify if text is used with the button and its placement (Buttons Text) and if graphical icons or 
snapshot pictures are used for the buttons (Pictures). The Apply button saves any changes made in this dialog. 

• To select a different icon or create a snapshot you must access the Icon Panel Button Properties dialog (see 
Figure 37).  This is done by first doing a single click on the button and then pressing the right mouse button to 
bring up the contextual menu for the button (Figure 36) and accessing the Properties command or by using the 
keys ALT+ENT.  Then click on the Icon tab and the Icon panel in (Figure 41) will be available for use.  

• The name of the Button in the HotBar you clicked on appears in the dialog and next to it is a drop-down list 
where you will find folders in the system containing a variety of graphics that can be used for icons.  As you 
select different folders, the contents of the folders will be shown in the main window of the dialog.  Choose a 
graphic image and then press the Apply key.  This will now become the new icon in the HotBar for this button. 

• Utilizing Snapshot images copied from the Render Output windows for the HotBar buttons is described in 
detail in section 3.5.3.  

3.5.3 Use of Snapshots 
The use of Snapshots requires three basic steps: 
• Selecting the Snapshots option 
• Capturing a Snapshot image from the Render Output Window 
• Assign the Snapshot image to the button  
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Snapshots are images copied from the Render Output window for use on button on the HotBar (see Figure 41).  
These buttons use images instead of icons but function like buttons.  To use Snapshots for the buttons in a 
HotBar, you must first select Snapshots in the Hotbar Properties dialog.  (see Figure 38).  To open this dialog, 
click on the title bar for the Hotbar and press ALT+ENT.  Select Snapshots and click on the Apply button to 
activate the other tools needed to create and use snapshots as buttons.  The icons for the Hotbar will now look 
like 35mm cameras. 
The next step to create a Snapshot is to click on one of the 35mm icons and press the right mouse button to 
display the contextual menu for the button.  On this menu you will find the menu Take&Set Snapshot 
(Figure 39 below). 

 
Figure 39. Contextual Menu with Take & Set Snapshot Command  

Selection of the Take&Set Snapshot command in the contextual menu first captures the current image in the 
Render Output window and then displays the Save As dialog shown below (Figure 40).  Here you can define 
which directory to save the capture image (the default directory is Shots) and the file name.  The only file type 
option available is bitmap so files are saved with the extenstion .bmp.  The default file name is the button 
description specified in the Button Properties dialog (see Figure 37).  The Save button saves the name and path 
for the image file and the Cancel button aborts the snapshot process. 
 

 
Figure 40. Save As dialog for Snapshots 
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To perform additional captures and assignment of an image to a button, you must use the Icon panel of Button 
Properties dialog (Figure 41). 

 
Figure 41. Icon Panel of Button Properties Dialog 

In the drop-down list of the Icon Folder allows choosing a directory to which images for the button are saved.  
As additional images are saved, they will be displayed in the window for the dialog. 
Using the Set Shot button assigns the selected image in the dialog window.  This image will immediately 
become the button on the Hotbar. Note, that pressing of button Delete deletes the chosen image as well as from 
your system hard drive. 
Action Panel 
The name, description and script for an Action assigned to the button are displayed on the Action panel.  The 
changes developed here are immediately reflected in the original script.  Similarly, changes edited in the script of 
Action in the library are immediately reflected in the button Properties panel by pressing the button .  Turn to 
section 3.4.2 for a detail description on the use of the Action panel. 
 

3.5.4 Contextual menu and dialog Properties for HotBars and Hotsets 
Contextual menu of Hotset contains the basic commands of manipulation of HotBars.  These commands are 
identical to commands of menu HotBar of the HotActions main window (see section3.5.6), except for presence of 
the command Properties.  To access this contextual menu do a single click on the title bar of the HotBar and 
then do a right mouse click.  (See Figure 42)The contextual menu shown will be available. 

 
Figure 42. Contextual Menu for HotBar 
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The Properties dialog of any HotBar in Hotset, is shown in (Figure 43).  More detail about working with buttons 
is found in sections 3.5.2 and 3.5.3. 

 
Figure 43. HotBar Properties Panel 

3.5.5 Alternative representation of Hotset as an Outline 
For configuration of a Hotset it is possible to use its alternative representation as an Outline document. 
This document contains one or several folders for each Hotbar in the Hotset (Figure 45).  To access this version 
of Hotset, do a right mouse click on any empty area of the Hotset and a contextual menu will be displayed with 
the command Configure (Figure 44). 

 
Figure 44. Contextual Menu for Hotset 
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Figure 45. Outline version of Hotset 

Accessing the Configure command presents the outline version of the Hotset shown above in Figure 45.  A click 
on the different Hotbar names on the left side of the screen displays the contents for that Hotbar folder on the 
right side of the screen.  Using the contextual menu for a button in this screen (see Figure 46), lets you perform all 
button management activities. 

 
Figure 46. Contextual menu of Outline window for a Hotset 

The check marks next to the Hotbar names indicate if the Hotbar can be displayed (checked) or is hidden 
(unchecked).  
The order of references in the folders corresponds to the order of buttons.  To add references in folders (and 
buttons on Hotbar) it is possible to drag Actions from an open Action Library, use references from other folders, 
or buttons from others Hotbars. 
Other activities can be done from the contextual menu.  For example, the divider between buttons of of Hotbar is 
inserted by pressing of button Insert or using command of contextual menu Insert Separator.  The similar 
command is in the contextual menu for the button (Figure 46).  The divider appears before the chosen (button) 
and can be removed by pressing  keys Ctrl+Del or use the command Delete from the same menu. 
References to Actions which are executed at each initialization of a scene, are located in a folder $STARTUP$, 
available in every Hotset.  Usually in this folder is located startup Action, and its Hotbar is usually hidden.  More 
about startup Actions is in section 3.11.2. 
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3.5.6 Hotset and Hotbar Menus in Main HotActions window 
Hotset Menu 
When working with a Hotset in the main HotActions window the dynamic menu Hotset (Figure 45) appears.  It is 
identical to contextual menu of Hotset with the following commands: 
• New Hotbar – creates a new Hotbar. 
• Fit Hotbars – changes sizes of Hotset such that all Hotbars are completely visible.  It does not stop the 

overlapping of Hotbars.  To avoid overlapping, use the Auto-Fit command. 
• Auto-Fit – this option changes all sizes of Hotbars such that all are completely visible and there is no 

overlapping of the Hotbars. 
• Open All Source Libraries – this command opens all Actions Libraries referenced in the Hotset. 
• Background Color… – opens dialog for choosing background area color of Hotbar. 
• Configure – represents Hotset as an outline document containing one or several folders for each Hotbars (see 

section 3.5.5).  

  
Figure 47. Hotset and Hotbar Menus of main window 

Hotbar Menu 
Also in the menu bar of the main HotActions window is the HotBar menu (Figure 47) that contains commands of 
manipulation of HotBars: 
• Cut – deletes chosen HotBar, placing it to the clipboard; 
• Copy – copies chosen HotBar to the clipboard; 
• Paste – inserts chosen HotBar from the clipboard to Hotset; this command is accessible if a HotBar is in the 

clipboard as the result of using the Cut or Copy commands; 
• Delete – removes chosen HotBar. 
Commands of the Hotbar menu are identical to commands on the local menu HotBar. 

3.6 Operations with Project 
HotActions organizes all its activities within the Project file.  HotActions only works with one project file at a 
time.  When opening another Project file, the system first asks if the current changes should be saved.  

3.6.1 Operations with project file 
To open any existing Projects choose the command Open Project… from File menu of the main HotActions 
window.  This opens a standard file dialog where you can select the file type Project so that only files with the 
extension .vsp are listed.  After the first opening a Project, the name of Project will appear under the command 
Recent Projects in the File menu.  
New Projects are created by the command New Project in menu File (Figure 48). 
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Figure 48. File Menu of main window 

To save the current Project you should use the commands Save Project or Save Project As… in the File menu 
(Figure 49)  Save Project As… command allows saving the project with a new name.  Also it is possible to use 
the button  if the main window to execute Save Project. 

 
Figure 49. File Menu of Open Project 

* Note: If you transfer a Project file by a method outside of the HotActions program, for example, the folder 
references to all files in the Project may now appear wrong, and to you will have to specify the path for each 
file. Therefore to copy a Project and preserve its connections to other files and folders, it is best to use the 
command Save Pro ect As…   All references to files will be updated automatically. j

3.6.2 Working with files and file groups in Project 
The window of each Project contains Standard Groups – with separate folders for each standard type of file used 
by HotActions: 
• Group Scenes for scenes (files with extension *.3d). 
• Group Hotsets for Hotset (files with extension *.hot). 
• Group Libraries for libraries of Actions (files with extension *.acl). 
HotActions also supports text documents (files with expansion *.txt). In the Project, an addition or creation of a 
text document causes the creation of the group Texts.  It is also possible to create a group for any type of file as is 
described further. 
At creation of files in the Project they are automatically saved to the appropriate group. If you try to add a file to a 
standard group that is not the same type as a file it will be placed automatically by the program in the group of 
files of that type. 
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Standard groups for files used by HotActions can not be removed nor renamed. However, a Custom Group can be 
created for non-standard file types. To create a Custom Group, perform a right mouse click in an empty area of 
the Project window. This will bring up the contextual menu shown in (Figure 50).  

 
Figure 50. Contextual Menu for Project 

Selecting the New Custom Group… command will display the panel below in Figure 51. Here you can enter a 
name for the Custom Group and save it by clicking on the OK button. Cancel button stops the creation of a 
Custom Group. In any Custom Group you can hold references to files of different types simultaneously. 

 
Figure 51. Custom Group Name Dialog 

• Commands Open All Files and Close All Files of the contextual menu of the Project window open and 
close all files accordingly, which are associated with the project. 

• Commands Unhide All Files and Hide All Files hide and show all files, which are included in the Project. 
• Command New Custom Group… creates a new custom file group (Figure 50 and Figure 51). 
• Command Add File to Project adds a file to the open project. However it is necessary to specify the path 

to the file in dialog.  
• Command Properties causes dialog Properties for last chosen group to be displayed (Figure 51). 

Contextual Menu for a Specific Group 
A click with the right mouse button on the icon for a specific presents the contextual menu for the file group 
shown in (Figure 50).  Commands available for working with groups include: 
• commands Open Group and Close Group open and close all files which are included in group. 

* Note: It is desirable to not close files used in the project since re-opening a file (particularly scene 
files)_can require a great amount of time.  If you do not want a particular file to be opened, it is 
recommended to hide files with the help of the commands described below. 

• Commands Unhide Group and Hide Group hide and show all documents which are included in group; 
• commands Delete Group and Rename… accordingly delete and rename Custom groups (standard groups 

can not be renamed or deleted); 
• command Properties causes the display of the Properties dialog for the group (Figure 52). 
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Figure 52. Contextual menu for a Group 

In the Properties dialog on the contextual menu for Group in the Project window, there are two panels File and 
Directories. (Figure 53)  Under the File panel you can a description for the group, which can help you find files.  
In the Directories it is possible to specify additional search paths for file types in the current project.  This panel 
concerns to the project as a whole and is identical to files and groups shown on the right in Figure 53. 

  
Figure 53. Panels File and Directories of the Group Properties Dialog 

If the file specified in the project is not found, the program searches for it, using the following methods: 
1. It looks in the current folder of the project. 
2. In the folders for the given type of file as specified in (Figure 53, on the right)  
3. In the Default Directories in Options dialog ( See 5.2),  
If the file can not be found then the message in Figure 54 is displayed. 
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Figure 54. Message displayed when File not found 

The Yes button opens a dialog to manually find the file. 

3.6.3 Project Menu of HotActions main window  
When a Project is opened, then the dynamic menu Project (Figure 55) is added to the menu bar for the main 
HotActions window. Commands of the Project menu duplicate commands on contextual menu for the Project 
window (Figure 50 and Figure 52). 

 
Figure 55. Project menu of main HotActions window 

3.7 Operations with text documents 
HotActions supports standard operations with text documents (files with expansion *.txt). At addition or creation 
of the text document, it is saved in the standard group Texts. 
For opening a file not in structure of the Project use the Open… command in File menu. Then in the Open dialog 
choose the folder and the name of a file to be used. You can confine the list of files displayed to those with the 
extension «.txt» in the drop-down list. Once opened the file will now appear on the list of files under the 
command Recent Files on File menu. At opening a file the program will ask, whether you would like to add it to 
the current Project. 

For saving changes in a file choose command Save from menu File or its equivalent – the button  on the tool 
bar. To save a file with other name use command Save As…. 
Using a new text document adds the choice of Text Document to the New dialog that is invoked with the 
command New in menu File of the main window or pressing of keys Ctrl+N. 

3.8 Control of HotActions in Live Action mode 
As discussed earlier (see section 3.1.6) HotActions has two modes of operation: Edit (editing) and LiveAction 
(operating conditions). 

To place the program in operating conditions (LiveAction) press the button  (Start LiveAction) on the tool 
bar of the main window. When engaged the image of the button is replaced by – .  To return to edit mode, 
press . 

In Live Action mode, by default the main window passes into a Fullscreen display, and if a second monitor is 
used an image of a scene will appear.  Adjustments to LiveAction mode are discussed under the details for the 
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Options dialog (see chapter 5).  Note that in LiveAction mode a dagger in a right corner of a window designates 
the file is hidden. 

The contextual menu for Live Action mode will appear with a click of the right mouse button of the mouse on the 
empty area of the main window.  

3.9 Use of mouse and joystick for control of objects  

3.9.1 Selection of Object for manipulation 
When you only have just opened a scene, in the structure of the Project, the object chosen for a manipulation, by 
default, is the object of a scene with the name ALL.  If an object with the name ALL does not exist, the object, 
which was chosen last at the previous opening the scene is used. 
In the working window of a scene (see Figure 56 below) it is possible to choose any object for manipulation, for 
example, the camera, by clicking on it twice with the left mouse. 

 
Figure 56. Output of selected object Camera01 

The name of the object chosen for manipulations is displayed in a window of a scene with a bold font.  In 
Figure 56 Camera01 is the selected object and its output is displayed in the Render Output window.  Note there is 
a special of script command <Current>, which indicates the current chosen object is to be acted upon by the 
script.  A change of the selected object changes the object addressed by the <Current> command. 
The following keys manipulate the chosen object: 

Tab cycles through the axes of rotation/moving; 
Space «blank», stops movement, reduces speed of object equal to zero; 
+ / – increase/reduce speed of movement of object, i.e. at the speed equal to zero, on movement 

of the mouse or joystick (or on pressing arrows of the keyboard), the object rotates around 
of the current axis. 

Modifiers: 
Ctrl on movement of the mouse or joystick or on pressing arrows of the keyboard the object is 

scaled along the current axis; 
Alt the object moves along the current axis in space of a scene. 

If the chosen object is the Camera the following keys are also available: 
Home  sets the focal length (Zoom) of camera in default; 
PgUp / PgDown increases/reduces the focal length. 
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Control of the camera by a joystick should be carried out not directly, but via empty objects (Dummy) to which 
the camera is connected for control of a scene created in 3D Studio Max. 

3.9.2 Joystick initialization 
If a joystick is to be used as a control device, it must be initialized as a Startup Action (see 3.11.2). The Action 
script must use the command «Init Joystick» from Action Library «Joystick.acl». This library is comes with 
VS2000 as an example of working with a joystick and can be found in the folder 
C:\Program Files\Darim Vision\VS2000 Software\HotActions\Common\ActLibs if the studio is loaded 
on disk C. 
The program’s Actions are made to manipulate an object by a joystick, and it also accept reactions of the program 
by engaging the joystick buttons. In Actions using a joystick the object for manipulations always is the current 
chosen object in a scene – and in script commands is referred to by the name <Current>. 
If it is necessary to change the reaction of HotActions to manipulations with a joystick turn to the document 
Script Commands Guide. 

3.10  Use of Debug Output window 
In HotActions it is possible to display diagnostic messages, error messages, warnings and other system 
information for purposes of tracing the source of problems with the system.  For this purpose the output window 
Debug Output is used.  The Debug Output window appears by selecting the option Debug Output in menu View 

or pressing Ctrl-Shift-0.  It is also available by pressing the button  on the tools bar of the main window of 
HotActions: (See Figure 57) 

 

Window Debug Output 
 

Figure 57. Debug Window Output button 

The types of messages displayed in the Debug Output window are determined in the Debug Output panel on the 
Options dialog.  Details on the use of this panel are described in section 5.3.  Debug messages and error message 
are also automatically saved to a log file.  The name of the log file is set in the Options Debug Output panel.  This 
file can be emailed to technical support if necessary.  
When invoked, the window Debug Output appears across the bottom of the screen.  To detach and turn this 
window into a floating condition, perform a double click on the windows left border with the left mouse button.  
It can be restored to a fixed position by using the command Docking View in the contextual menu for the Debug 
Output window or a double left mouse click on the top border of the window.  (Figure 57)  
Options Show Columns of the contextual menu allows to inclusion of two additional columns: sending time and 
module name.  The sending time is in the format «minutes:: seconds:: milliseconds» (column head Time), and 
information on which module of the program initiated the debug message is shown under the column headed 
Module. 
Command Clear clears the window of all received messages, but does not delete them from the log file.  
Command Hide is equivalent to closing of the Debug Output window. Icons to the left of the message correspond 
to its category (Figure 58). 

42 Chapter 3   Application HotActions 



  3.11 Use of scene files (*.3d) in HotActions 

 
Figure 58. Debug Window 

3.11 Use of scene files (*.3d) in HotActions 
A full example of working with scenes for use during the creation of a Project is depicted in the document 
3D Scene Creation Guide.  To learn more about creating objects that can be used in scenes created in 
HotActions, turn to the manual for 3D Studio Max.  Scene files created by HotActions have the file extension .3d. 
Scene files can be used in existing projects of HotActions or used in the creation of a new project.  Tools to 
control actions of objects in scenes are described in the following sections. An Action is a series of text 
commands.  They are universal, easily changed and transferable. Every Action can be executed by a pre-assigned 
specific button. 

3.11.1 The function of startup Actions 
Actions are organized in Actions Libraries (files with expansion *.acl). The Project file contains references to all 
files used by the Project including Action Libraries. 
Actions that initiate a scene are found in the folder $STARTUP$.  The folder $STARTUP$ is created 
automatically in every Hotset.  By default this folder is hidden, but it can be made visible through the configure 
command on the Hotset contextual menu.  (see section 3.5.5). HotActions automatically executes the contents of 
$STARTUP$ folder when HotActions is put into LiveAction mode or on pressing the button  on the tool bar 
of the main window.  Note, this button is accessible only when a project is open in Hotset. 
Actions in the $STARTUP$ folder are carried out in a precise order – but it is possible to change the order of 
execution by changing references in the $STARTUP$ folder.  It is possible to alter the contents of an existing 
$STARTUP$ folder as a basis for creating a new $STARTUP$ folder in a new project.  Some of the advantages 
to re-using startup Actions are uniformity of work between projects and it may be possible to execute an 
unfamiliar project to get a feel for how it looks by pressing the button  . 

3.11.2 Creation of startup Actions 
The primary task of startup Actions is to set the initial working conditions.  The basic required actions are listed 
below. The example is startup Actions for a scene in the sample project Sport. They are in the script – 
«Init Sport»: 
• First required action is to load a scene 

:DATA.OPEN = «Sport.3d» 

• Objects of a scene can be animated.  These movements are controlled by trajectories (also known as tracks). 
For control of trajectories in HotActions it is necessary for them to have assigned names.  This is important 
since objects created in 3D Studio Max do not have set names for trajectories. 

:TRACK.CAM_SPORT.NODE = CAMTRACK 
This command assigns trajectories of object «CAM_SPORT» the name «CAMTRACK» for further reference in 
the Action script for this object.  
• After transfer and naming of all trajectories, it is necessary to place the following command, to start the tracks: 

:DATA.PLAY = 1 
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• Another requirement at startup is the specification of video streams for a scene and their connection with 
available materials: 

:RENDER.VIDEO.LIVE_1.CREATE = 1 
This command creates a video stream connected to first board FD300 in system LIVE_1 in drop-down 
list Input(s) (Figure 5) 
:RENDER.VIDEO.LIVE_1.LINE = A 
This command selects first channal (Line A, Figure 5) of board FD300 
:RENDER.VIDEO.LIVE_1.FORMAT = ALPHA 
Establishes the format of the video stream as alpha - mixing is set. 
:RENDER.VIDEO.LIVE_1.START = 1 
Begins video stream. 
:RENDER.MATERIAL.VIDEO.SOURCE = LIVE_1 
Assigns a material with name VIDEO a video texture from the video stream LIVE_1, which will be 
imposed on all objects in the scene with this material. 

In startup Actions after loading a scene and naming of tracks any typical Action can be part of the $STARTUP$ 
folder. 
Detail about each command is found in the manual Script Commands Guide. 
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window 

4 Render Output window 
The Render Output instantly displays the results of working in the HotSet of VS2000.  Ideally when working with 
VS2000 this window is seen on a second monitor by utilizing the expanded display in Windows.  The system 
comes with a graphic accelerator, which allows the additional monitor for enhanced productivity.  In LiveAction 
mode the Render Output window will be rendered in full screen on the additional display. 

4.1 Menu commands of Main Window for Render Output window 
Two menus of the main window have commands that affect the Render Output window.  
Window menu 
Command Center Render Window in menu Window of main window HotActions (Figure 59) places window 
Render Output in the center of a window.  This is used primarily in one-monitor system configurations.  
View menu 
The command Render Window in menu View (Figure 59, on the right) dictates whether the Render Output 
window is displayed or hidden. The key combination Ctrl+0 toggles between the hidden and displayed states for 
the Render Output window. 

  
Figure 59. Window and View menus of main HotActions window 

4.2 Menus on the Render Output Window 
Three menus are available on the Window Render Output window – View, Options and Tools.   
View Menu 
Menu View (Figure 60 left) of window Render Output contains the following commands: 
• Frame Rate, which allows to output some average information on productivity of studio at the given 

sanction; 
• Three different Screen Resolutions each available with a hot key combination. 

o 320 x 240 – ALT+1 
o 640 x 480 – ALT+2 
o 768 x 576 – ALT +3 

• Fullscreen allows display in a full screen mode.  To exit full-screen mode use the hot key combination Ctrl-
Shift-End. 

4.2.1 Options Menu 
In menu Options (Figure 60, on the right) command Engine opens dialog with information render engines used 
by VS2000.  Command Render opens Render Options dialog with the information about the graphic display 
settings used with the VS2000 system. Both dialogs are described in section 4.3 below. 
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Figure 60. View and Options menus of Render Output window 

4.2.2 Tools Menu 
Using the commands of menu Tools (Figure 61) it is possible to print or save a bmp-file of the current image in 
window Render Output. 

 
Figure 61. Tools menu of Render Output window 

4.3 Dialogs of image settings 

* Note: It is not recommended to change the default setting of the dialogs described below without assistance 
of technical support.  This information is given for the purpose acquainting you with the dialogs. 

Dialog Render Options (Figure 62) contains information about settings of the display module of VS2000. It is 
presented by pressing of button F11 on the keyboard or using the command Engine in menu Options of window 
Render Output. 

* Note: In drop-down list Mode on panels Devices it is possible to change the resolution of video under 
operating conditions (LiveAction).  Value Auto provides correct setting in required by selected TV standard 
(PAL or NTSC).  Setting of the resolution from list Mode does not change the resolution established in the 
dialog for Display Properties of operational system (Figure 1). 
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Figure 62. Panel Devices of the Render Options dialog 

Dialog Choose Render Engine (Figure 63) displays information on the version and path for display library of 
VS2000. The dialog is displayed by pressing of button F12 on the keyboard or accessing the command Render in 
menu Options of window Render Output.  The information is required technical support. 

 
Figure 63. Dialog Choose Render Engine 
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5 Dialog Options – general settings of studio 

The button  on tools panel of HotActions main window (Figure 64) opens dialog Options for installation of 
working settings of VS2000 application. 

 

Settings 

Figure 64. The tools button of HotActions main window 

Settings on the panel Live Video of dialog Options is described in the document “Video and Sound Settings 
Guide” for VS2000.  Other panels of dialog Options are described in this chapter. 

5.1 Settings of LiveAction mode 
Panel LiveAction Mode (Figure 65 and Figure 66) of Options dialog is used for settings of LiveAction mode. 

* Note: It is not recommended to change the default values.  The default values can be restored by pressing 
the button Default. 

 
Figure 65. Panel LiveAction Mode of Options dialog 

5.1.1 Main Window Parameters 
In the Main Window group you can set the following parameters of LiveAction Mode mode: 

Always On Top selects of the basic window to be atop windows of other applications; 
Maximize to Fullscreen causes the basic window to cover the whole screen; 
Hide Menu hides the menu bar of the basic window; 
Hide Toolbars hides the tool bar in the basic window; 
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Hide Status Bar hides the status bar in the basic window; 

5.1.2 Render Window Parameters 
The Render Window group controls the following parameters: 

Disable Fullscreen in single-monitor configuration 
 prevents switching to full screen mode in single monitor configurations. The option 

Full screen in menu View of window Render Output becomes inaccessible. 
Switch to Fullscreen 
 dictates switching to full screen mode in the Render Output window. On one-monitor 

configurations, selection of this option will not occur, if the Disable Full-screen option has 
been selected; 

5.1.3 Debug Output Parameters 
Options available in  Debug Output group: 

Hide Output window 
 Hides the window of Debug Output dialog in LiveAction mode; 
Disable all Output (no logging) 
 when selected cuts off the output of error and debugging message to the log file. See 

section 5.3. 
Project Window Parameters 
Settings group for  Project Window : 

Disable Closing prevents closing of the project while in LiveAction Mode; 
Show Normal displays windows in usual mode; 
Show Minimized minimizes project window. 
Hide hides project window. 

Scenes Window Parameters 
Controls for Scenes Windows: 

Show Normal shows scene window as usual window; 
Show Minimized minimizes scene window; 
Hide hides scene window. 
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Figure 66. Panel LiveAction Mode of Options dialog 

Hotsets Parameters 
The parameters of the Hotsets group control the initial settings for Actions: 

Auto-run actions in ‘Startup’ folder 
 Sets the automatic performance of Actions from folder «STARTUP»; 
Always open if included in Project 
 automatically activates windows of all Hotsets during transition to LiveAction mode. 

The text field Startup’ Folder Name installs the name of the folder containing startup Actions in Hotsets. 
Actions in the folder with this name are carried out automatically each time the application is switched to 
LiveAction mode (section 3.11.1). 
Button Default restores default settings. 

5.2 Settings for Default Directories 
On the panel Default Directories (Figure 67) are the settings for determing the order the application searches for 
files such as icons, pictures, libraries etc.  The default order for searching for files by type used is the following 
sequence: 
1. In the current folder of the project, i.e. where the file (*.vsp) is located. 
2. In the additional folders specified in the project for a given type of file (Figure 53, on the right).  
3. In the default for a given file type specified on Default Directories panel (Figure 67) with the indicated path. 

* Note: The task of directories is more than just grouping files, it is grouping them by file type as well..  Files 
of the certain type will only be searched for in the designated directories of the project.  
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Figure 67. Panel Default Directories of Options dialog 

Paths for scenes, Action Libraries and Hotsets are saved as designated by the settings in the Default Directories 
panel.  Files are only searched for by the specified order if the file is not found at opening the project.  If 
requested file is not be found, then an error message similar to that in Figure 68 is presented. 
If the program does not find graphic, sound and video-files, the referenced by script commands the program will 
generate error messages.  If the option Script Trace (section 5.3) is selected, these messages appear in window 
Debug Output (Figure 69). 

 
Figure 68. Error messages when specified files are not by an executed command 

Note that the message for file not found also occurs if the file is damaged.  Details on working with video are 
specified in the document Script Commands Guide. 
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5.3 Panel Debug Output 
The last panel of the Options dialog is Debug Output. This determines which types of messages are displayed in 
the Debug Output window (Figure 69). The icons located at the left of a category will appear in the message 
window of Debug Output (see 3.10). 

 
Figure 69. Panel Debug Output 

Errors  displays error messages; 
Warnings displays warnings; 
Info displays the various information: about productivity of the system, the loaded data etc. 
Runtime (from Actions) 
 displays messages upon executing Action (see the chapter about the script command 

SYS.OUTPUT, used to deduce such message); 
Script Trace  displays the information during the course of execution Action. Serves for debugging 

scripts; 
Debug Messages option for developers, displays messages of debugging; 
System Debug Strings 
 option for developers; displays the system debugging information (OutputDebugString). 

Note that selection of this option causes the application to intercept and deduce all 
messages Windows, including those from other applications; 

General (No type)   
 displays all remaining types of messages. 

Buttons None and All set or reset all options simultaneously. 
The input field Log File Name sets the name for the file to record messages.  The file is saved to the specific 
directory Windows for times.  This directory is adjusted for each user with the variable environments for 
Windows.  You can find a path to this directory in the dialog Environment Variables.  This dialog is displayed by 
the following sequence of actions: 
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• Click the right button of the mouse on the icon «My Computer» on the Windows desktop. 
• The System Properties dialog is displayed, select the tab Advanced (Figure 70, at the left) and press button 

Environment Variables. 
• In the Environment Variables dialog look at list User Variables for … (Figure 70, on the right) where there 

should be the name of the current user logged into Windows. 
• Look in field Variable for the variable with name Temp.  The field Value of this variable contains the path to 

directory for time file in Windows.  This is where the log file for recording of debug messages is saved. 

  
Figure 70. Systems Properties dialog (left) and its Environmental Variables dialog (right) 
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6 Troubleshooting 
If you encounter a problem for which you can not find a solution in this chapter, you should contact to technical 
support.  Information that is required for solution of a problem technical support may be in the file Output.log 
(see use of debugging messages is section 3.10). 

6.1 Problems with working directories 
Upon starting the program may ask to specify the working directories for icons (Figure 71), plug-ins, files for 
scene, libraries, HotSets, sound and image files. 
This occurs if during the installation of the program (as well as installation of updates) it could not create the 
folder Common in which all standard working directories are placed, or this folder was removed in error. 

 
Figure 71. Dialog for setting of an icon’s directory 

If you have always used the standard installation method and this problem occurs you should reinstall HotActions. 
If reinstallation does not help, or you if have used some other, non-standard installation procedure, it is possible to 
set required directories manually. 
If the application is on disk G, dialogs (like the one shown on Figure 71), display a path to the directory 
G:\Program Files\Darim Vision\VS2000 Software\HotActions.  You can, however, specify any directory 
path you like.  Any path to working directories can always be changed on the Default Directories panel (see 
section 5.2). 

6.2 Problems with FD300 board 

6.2.1 One or several boards are not found in system 
If in the Sound, video and game controllers section of the Device Manager dialog accessed by the menu 
commands (Start/Settings/Control Panel/System/Hardware/Device Manager) there is no board 
available or the  icon is next to the device name, most likely the board is not properly seated in the slot and it is 
not making a good contact with slot.  Completely turn off the computer, open the box and check to see if all 
boards are snuggly fitted in their slots. 
If the same message occurs when the computer is rebooted and VS2000 is initiated, it is then possible that the 
FD3000 board is faulty.  You should contact technical support immediately. 
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  6.3 Problems with keying 

If the board is now listed on under the Sound, video and game controllers of the Device Manager, but it is 
not identified as DarimVision FDXXX Video Board do the following steps: 
• Remove all incorrectly installed boards from the list of devices.  For each board click on its icon with the right 

button of the mouse and in the pop-up menu choose Uninstall…. 
• Right-click on the Sound, video and game controllers section and in the pop-up menu choose 

Scan for hardware changes. 
• Windows will find new devices and if the software was installed correctly, will find appropriate driver. 

6.2.2 Problems with the image from cameras while adjusting input or output video 
If the Input window of KeyConfigPro dialog remains grey while input and format are correctly set, reload the 
computer. 
If the camera image problem has arisen after installation of a board, most likely the install registration for the 
board is incorrect. 
Reinstall the board (as described in previous section) and registration (*.reg) file. 

6.3 Problems with keying 

6.3.1 Message Unspecified error in KeyConfigPro dialog  
In some cases, if there is an incorrect adjustment of VS2000 or a board, the following message (Figure 72) will 
appear with repeated attempts to adjust keying with KeyConfigPro dialog. 

 
Figure 72. The error message while working with KeyConfigPro dialog 

If you use a second computer monitor as the device for output video see chapter 4, otherwise, restart of 
HotActions does not help then completely reboot the computer.  

6.4 Problems with output video 

6.4.1  Single monitor configuration 
At startup the program finds all graphic accelerators available in system.  In a one-monitor configuration if the 
monitor is not connected to an output accelerator, the program, nevertheless, still uses this accelerator for the 
rendering.  It may cause error messages similarly to those shown in Figure 74 if the output for error messages is 
selected for the Debug Output window (section 3.10).  
A possible solution is to connect the monitor to an output of the graphic accelerator.  The following step describe 
how it to connect it correctly: 
• Set the monitor Softlab DVI to Video Convertor on NVIDIA GeForce Ti 4600  to the setting Primary in 

the Display Settings dialog (see Figure 1). 
• Physically connect the monitor to an output of an accelerator. 
• In Display Settings dialog (see Figure 1) uncheck Extend my Windows desktop onto this monitor option. 

If you this is not done, the system will show windows such as Windows Security dialog for the password 
during the Windows loading. 
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6.4.2 Double monitor configuration 
If you want to use a second computer monitor for output video, it must be connected it to the output of the graphic 
accelerator.  To properly connect the second monitor do the following adjustments: 
• In properties of the monitor for output video (as described in section 2.2), select Analog Monitor instead of 

Digital Display (Figure 1). 
• Start HotActions and select Internal->Analog encoder in Video Output Switching drop-down list of 

Output Mode Configure dialog (Figure 6, see also the document Video and Sound Settings Guide). 
Otherwise the keying message shown in shown in Figure 72 will be displayed while working with 
KeyConfigPro dialog.  

6.4.3 Changes in setting of input video from studio not accepted 
If DVM panel of Format dialog (displayed after clicking on the Format button in the Options dialog) stays 
inactive, or its adjustments are not accepted, you must reboot the system.  This will help guarantee that 
management from VS2000 has been enabled for DVM board. 

6.4.4 No output image 
If the output image is absent, check cable connections and output connection of the graphic accelerator of DVM 
board. 
In properties of the monitor for output video (as described in chapter 2.2) double check that the device of output 
video selected is Digital Display.  Note this option is only available if the cable for DVM is connected to the DVI 
output connector of the graphic accelerator. 
Also check in the DVM panel of the Format dialog (displayed after clicking Format button of Options dialog) 
mode Mode 1 or Mode 2 is selected in Video Conversion drop-down list.  This dialog is described in detail in 
the document Video and Sound Settings Guide. 

6.4.5 Display problem after change of format of output video   
If a display problem occurs when format of output video is changed (see adjustments of DVM board in the 
document Video and Sound Settings Guide) and the image on the output monitor begins to shake, it is necessary 
to reboot the computer.  Also there may be a message (Figure 73) pointing out the discrepancy of formats. 

 
Figure 73. The message with the warning about discrepancy of formats 

6.4.6 Problems with use of modes of the boards which are distinct from No Genlock 
If in any of the modes of a board are distinct from No Genlock, you may get unnatural, green or crimson colors 
and flashes of the image.  Set the parameters XOffset and Yoffset in the Output Mode Configure dialog 
(Figure 6) to zero. This dialog is described in the document Video and Sound Settings Guide. 

6.4.7 Shaking of fragments of the output video 
If the output image shakes this may mean that at startup the DVM board is incorrectly accepting DVI signal from 
the graphic accelerator. To make it work correctly you need to restart the system in desired mode. 
For this purpose go to the DVM panel of Format dialog (displayed after clicking Format button of Options 
dialog) and replace the mode with a new mode, for example Mode7, the click on the Apply button.  If you still 
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  6.5 For DDClip and Forward Software users 

have a shaky image try a different mode until you find the one that works for you and press Ok.  Dialog Options 
is described in the document Video and Sound Settings Guide. 

6.5 For DDClip and Forward Software users 
Playback of DV-files with script commands can fail with an error message similar to that shown in Figure 60 if an 
earlier version of the Future software or DDClip is installed.  
This can occur during installation of software that uses shared program’s components and are replaced with an 
older version that is not compatible with VS2000.  The problem is solved by reinstallation of VS2000 software 
after updating of the above-stated programs. 

6.6 Problems caused by switching off the second monitor  

6.6.1 Error message or program failure 
If you have disconnected the second monitor for output video and had switched off the 
Extend my Windows desktop onto this monitor option from Start->Settings->Control Panel-
>Display Properties but have not moved the Render Output window to the first monitor, 
the following error message typically occurs. 

 
Figure 74. Render error message 

If you try to initialize the scene loaded by the project after pressing OK, the program continues to work, but the 
results will not be displayed in the Render Output window. To return Render Output window to your working 
monitor, use the Center Render Output command in View menu. 

6.6.2 While working with one monitor scene doesn’t rendered correctly in Render 
Output window 

In menus of the main widow Start->Settings->Control Panel->Display Properties select the option 
Extend my Windows desktop onto this monitor as the option for your second monitor. Move Render Output 
window to the second monitor and return it back by Center Render Output command in View menu. 

6.7 Technical support 
You can receive technical consultation by contacting us at the following email addresses. 
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7 Appendix 

7.1 Schematic for connecting components of studio 
For VS2000 to work correctly, its components must be connected correctly. 
VS2000 comes delivered with the computer with both hardware and software completely configured. The only 
installation procedure required of you is to connect of the components with appropriate cables to the back panel of 
the computer. 
The following connections are required: 
• The DVI-output of AGP graphic accelerator (GeForce) must be connected to a DVI-connector of the DVM 

board (Figure 75 at the left). 
• If the graphic accelerator is working with two monitors, it is possible that both its connectors will be digital 

(DVI). If there is no additional video adapter, then the top DVI connector is used for Windows desktop and the 
bottom is connected to DVM. 

• Connect the VGA-monitor that is used as the monitor for Windows desktop to a connector of the video 
adapter. With the help of this monitor you can operate VS2000. The following variants of the video adapter are 
now possible: 
• Additional PCI VGA adapter (Figure 73). 
• The on-board video adapter (motherboard). Its DSUB connector should be on the back panel in the same 

place where there are connectors for the keyboard and the mouse. 
• Support of two monitors by video accelerator with AGP. As a rule, top DVI connector is used for Windows 

desktop and the bottom is connected to DVM. 

* Note that the second connector of the AGP accelerator should not be used for connection of the VGA-
monitor if there is another VGA-adapter! 
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  7.1 Schematic for connecting components of studio 

8 The passive switching panel BREAKOUT BOX 
The passive switching panel BREAKOUT BOX (Figure 76, Figure 77) is for connection of analog audio and 
video signals. This panel is connected to FD300 board socket by the special cable delivered together with the 
panel. 

 
Figure 76. Appearance of the passive switching panel (BREAKOUT BOX) 

Appearance of the passive switching panel is on Figure 76. All video inputs are parted for convenience into 3 
identical groups. Each of them has inscription VIDEO INPUT and number of input group. Each group contains 4 
coaxial sockets (A, B, C, D). Depending on device operating mode the following signals can give on video inputs: 
• on input A – CVBS-A, LUMA-AB, CSYNC; 
• on input B – CVBS-B, CHROMA-AB, Y, YS, G, GS; 
• on input C – CVBS-C, LUMA-CD, U,B; 
• on input D – CVBS-D, CHROMA-CD, V, R; 
where: 

• CVBS – composite video signal; 
• LUMA, CHROMA –S-Video signal components; 
• Y, U, V –YUV signal components; 
• R, G, B –RGB signal components; 
• CSYNC – separate synchro-signal of component input; 
• YS, GS – synchro-signal of component input contains in component Y or G. 
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Figure 77. The passive switching panel (BREAKOUT BOX) 

Video outputs are in the VIDEO OUTPUTS group. There are four video outputs RED/V/C, GREEN/Y, 
BLUE/U/CVBS and CVBS/CSYNC. All possible combinations are submitted in the table (Figure 78). 

 VIDEO OUTPUTS connectors 

Possible 
combinations RED BLUE GREEN CVBS 

Y/C+CVBS C(Chroma) CVBS Y(Luma) CVBS 

YUV+CVBS V U Y CVBS 

YUVS V U Y Sync 
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RGBS R G B Sync 

YUV+Key/α V U Y Key/α 

Figure 78. The table of video output combinations 

* Signal YC (S-Video) it is IMPOSSIBLE to remove simultaneously from socket miniDIN-4 S-VIDEO and 
sockets GREEN (Y – a brightness signal) and RED (C – the color signal). The chroma signal (С) should be 
loaded on 75 Ohm. Some equipment SONY (monitors, video recorders) HAVE NOT this loading and it should 
be provided. 

The audio signals are parted on 2 groups: output signals – AUDIO OUTPUTS, input signals – AUDIO INPUTS. 
In each group six sockets are located as three L-R stereo signal. 
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  7.1 Schematic for connecting components of studio 

9 The active switching panel BREAKOUT BOX 
Appearance of the active switching panel is on Figure 79. 

 
Figure 79. Appearance of the active switching panel (BREAKOUT BOX) 

All video inputs are parted for convenience into 3 identical groups (Figure 80). Each of them has inscription 
VIDEO INPUT and number of input group. Each group contains 4 pairs of passing parallel coaxial BNC-sockets 
(A, B, C, D) and 2 sockets as MiniDIN4 for connection with S-Video signals (inputs AB and CD). With help of 
switches COAXIAL/S-VIDEO the choice of used sockets is carried out. Switches OFF/ON serve for switching 
on/off of terminal resistors 75Ohm corresponding coaxial video input. 
Depending on device operating mode the following signals can give on video inputs: 
• on input A – CVBS-A, LUMA-AB, CSYNC; 
• on input B – CVBS-B, CHROMA-AB, Y, YS, G, GS; 
• on input C – CVBS-C, LUMA-CD, U,B; 
• on input D – CVBS-D, CHROMA-CD, V, R, 
where: 

• CVBS – composite video signal; 
• LUMA, CHROMA –S-Video signal components; 
• Y, U, V –YUV signal components; 
• R, G, B –RGB signal components; 
• CSYNC – separate synchro signal of component input; 
• YS, GS – synchro signal of component input contains in component Y or G. 

 VS2000 61 



 

INPUT

VIDEO INPUTS 1
CSYNC

LUMA AB
CVBC

Y/GREEN
CHROMA AB

CVBS

U/BLUE
LUMA CD

CVBS

V/RED
CHROMA CD

CVBS

OFF ON
75 75 75

OFF ON OFF ON OFF ON

NO YES
YS/GS

AB CDCOAXIAL
S-VIDEO

A B C D

A B C D

VIDEO INPUTS 2
CSYNC

LUMA AB
CVBC

Y/GREEN
CHROMA AB

CVBS

U/BLUE
LUMA CD

CVBS

V/RED
CHROMA CD

CVBS

OFF ON
75 75 75

OFF ON OFF ON OFF ON

NO YES
YS/GS

AB CDCOAXIAL
S-VIDEO

A B C D

A B C D

VIDEO INPUTS 3
CSYNC

LUMA AB
CVBC

Y/GREEN
CHROMA AB

CVBS

U/BLUE
LUMA CD

CVBS

V/RED
CHROMA CD

CVBS

OFF ON
75 75 75

OFF ON OFF ON OFF ON

NO YES
YS/GS

AB CDCOAXIAL
S-VIDEO

A B C D

A B C D

PUSH

AUDIO INPUTS

PUSH PUSH PUSH PUSH PUSH

1L 1R 2L 2R 3L 3R

OFF ON
600

OFF ON
600

OFF ON
600

OFF ON
600

OFF ON
600

OFF ON
600

PUSH

AUDIO OUTPUTS

PUSH PUSH PUSH PUSH PUSH

1L 1R 2L 2R 3L 3R

AUDIO MONITOR
HEADPHONE

SELECT

1      2      3

MODE

LR    LR    RR

VOLUME

MIN                     MAX

OUTPUT

SPDIF

V/RED
CHROMA

Y/GREEN
LUMA

U/BLUE/CVBS CSYNC/CVBS

VIDEO OUTPUTS

TF785M BREAKOUT BOX

DARIM VISION / SOFTLAB NSK

POWER

DEVICE
LINK

 
Figure 80. The active switching panel (BREAKOUT BOX) 

When on video input of channel component signal with YS or GS component is given, switch YES/NO should be 
settled in position YES. In other cases it should be in normal position NO. 
On the panel there are also four video outputs RED/V/C, GREEN/Y, BLUE/U/CVBS, CVBS/CSYNC, 
incorporated in functional group VIDEO OUTPUTS. Each video output is duplicated, that allows to connect 
simultaneously with a working signal the monitor of preliminary viewing. 
Functional group AUDIO INPUTS is formed by six sockets, which are grouped as three L-R stereo pairs. All 
audio inputs are organized as symmetric (balancing) to what apply three-polar (stereo) sockets. Switches 
OFF/ON serve for connection / switching-off of terminal resistors 600 Ohm at a corresponding audio input. 
Functional group AUDIO OUTPUTS is formed 6 symmetric (balancing) audio outputs. They can be used as 
asymmetrical by grounding one balancing line the same as also audio inputs. 
In group AUDIO MONITOR HEADPHONE it is located socket for connection of a stereo headphones. The level 
of output can be settled by the regulator of loudness VOLUME. The choice of audio output number (1, 2 or 3) for 
cross talking is carried out by the switch SELECT. Switch MODE allows to set the necessary mode: LR – stereo, 
LL – only left channel, RR – only right channel. 
The light-emitting diode indicator POWER inform about power presence. 
If after FD300 board connection to the active switching panel light-emitting diode indicator POWER does not 
burn, it is necessary to address to the developer. 
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